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How Can I Teach My Windows Mouse New Tricks?

 (And When Should I Buy a  New Mouse?)
by Gabe Goldberg, Computers and Publishing, Inc.

F
or many people, the Windows mouse hasn’t evolved much since the dawn of the PC. This

is especially true of bottom-bargain gadgets often provided as standard PC purchase

accessories: two buttons boringly labeled Left and Right, wired to the computer, and

sensing motion through a small rotating sphere in contact with a desk or mousepad. If you’re

using one of these, a very economical upgrade can greatly improve your mousing game.

Perhaps the most basic mouse-tech enhancement was the scroll wheel, first available a

decade or more ago, allowing easy up-and-down motion within most applications’ files. If your

hand is already on the mouse for file editing, spinning the wheel can be much more convenient

than moving the cursor to the scroll bar and then back to the file area. 

Since some mouse software only handles basic tasks, more exotic functions may require

a simple software install. 

(Many manufacturers provide diverse mouse critters and other pointing/tracking devices;

if you’re not using a Microsoft mouse, check the Web site for whatever gadget you have at

hand, since similar capabilities may be available.) <http://www.loc8tor.com>

Googling “intellimouse” takes you to <http://www.microsoft.com/hardware/mouseand

keyboard/ProductDetails.aspx?pid=003>

Microsoft’s Web page, where you can click Download Software and navigate to <http://

www.microsoft.com/hardware/download/download.aspx?category=MK> Download Mouse and

Keyboard Software and select/download software for your device.

Many Microsoft mice (“mouses”?) allow tilting the scroll wheel left/right for horizontal

scrolling of files too wide to fully display, providing convenient two-dimensional motion. And

some allow the scroll wheel to be a third button to click, providing instant access to your

favorite common function.

Even better, many Microsoft mice add another button or two, potentially making available

a total of five quick-action functions. Intellimouse software provides great flexibility in

defining mouse-button actions, such as Show/Hide Desktop, Forward/Back browser funtions,

Magnify, Copy/Cut/Paste, etc. Setting a button to Magnify gives one-click access to a tailorable

(size/shape and degree of magnification) magnifying glass that’s great for viewing small

/intricate on-screen details.

Wireless mouse operation avoids tangling the mouse cable in desktop clutter and

optical/laser operation is smoother and more reliable than old-style mouseball motion sensing.

New mouse shapes are more ergonomic, improving hand positioning, important for people in

intimate contact with their mouse for many hours per day.

And Intellimouse software—free to download—provides many more mousing capabilities

and options including tailorable pointer icons, trails, and speeds. Don’t settle for Mickey

(mouse) when Mighty (mouse) is available. After buying a new device, check for newer

software than came in the package—you may pick up features or bug fixes. 

This article first appeared on the Tiplet Web site, <www.tiplet.com> and is copyrighted by the

author, Gabriel Goldberg. All rights are reserved; it may be reproduced, downloaded, or disseminated,

for single use, or by nonprofit organizations for educational purposes, with attribution to Tiplet and the

author. It should be unchanged and this paragraph must be included. Please e-mail the author at

tiplet@gabegold.com when you use it, or for permission to excerpt or condense.
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OpenOffice.org Templates

The Easy Way to Create New Documents
by Charles Olsen

I
f you do a lot of work in OpenOffice.org Writer, chances are that you prepare many documents of a

similar format. If you’re not using templates to create these documents, you may be doing a lot of extra

work.

A lot of what I write in this article will also apply to other office application suites, including Microsoft

Office. But the exact details will be different with Microsoft Office and other programs.

This article will apply to OpenOffice.org (OOo) on both Linux and Windows—and possibly on Mac,

but I don’t have a way to verify that.

What is a template?
A template is simply a document that serves as a model when you’re creating new

documents. It has margins, fonts, styles, and can include text and graphics that you want to

have included in your documents.

OOo uses templates for all its documents: word processing, spreadsheet, presentation and

drawing. When you create a new document, it will use the default template for that type of

document unless you specify another template to use. Out of the box, the default templates are

blank. They’ll have margins and fonts, but will not include any text or graphics.

Why Use a Template?
Once you have templates set up, they can make your life easier. For example, if you send

a lot of letters, you can have a template that includes your name and contact info, a graphic

logo, has set the font that you want to use, and includes place holders to show where to put

the new text.

One template that I’ve used a lot in the past is for magazine articles. When you’re

submitting articles to magazines, there’s a specific format they want to see. You need to have

the margins set to a certain size, with specific text in specific locations, and using a particular

kind of font.

(The Courier 10 Pitch font that comes with Linux Mint and most other distros is a really

good font for this. Set the size to 12 point, so that it’s printing 10 characters per inch. The

Courier New font that comes with Windows is kind of wimpy—a better one is this free Dark

Courier font from Hewlett Packard: http://tinyurl.com/2g2a3).

If a writer fails to follow this specific format, it tells the editor that this writer does not pay

attention to detail. If the writer isn’t paying attention to detail, then how can you know that

the information in the article is correct? By using a template, you know that all the formatting

will be correct and you’re free to focus on the content.

At the company where I work, we send a lot of letters that have legal impact. The exact

words you use, and the exact phrasing, can make a big difference. So we use templates for

most of the letters we send. Many of our templates already have the text which has been

reviewed and approved by our legal department, so we just have to fill in the name and

address, and other info like the account number and specific amounts. Using templates keeps

us consistent on the messages we send.

Or if you have a report that you create regularly—weekly, monthly or whatever—you can

have a template in Word Processor or Spreadsheet or Presentation that has the format set up,

as well as headings or titles or any other text that needs to be there each time.
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You can see that using templates can make your life easier, can make your documents

consistent and even help keep them legal.

How To Create a Template
There’s more than one way to create a template. I’m going to talk about the process I use,

but this is not the only way to get it done.

The best way is to start with a document you’ve already created, where everything is set

up exactly the way you want it. Then you just need to remove the text that would change each

time. I’ll use the example of creating a template for magazine articles.

I’d start with an article that had everything set up correctly:

C Margins are set

C Appropriate font has been selected

C No page number on the first page

C My last name and the page number on all the rest of the pages

C Top of the first page on the left is my name and contact information

C Top of the first page on the right is the word count, copyright notice and rights I’m

selling

C The title, centered and all uppercase

C The byline

C Halfway down the first page, the article begins

C At the end, after the article content, it has the words “The End” centered on the page

The first thing I’d do is click File > Save As and give this file a new name. Since I’m going

to be deleting most of the text from the article, I don’t want to take a chance that I would

accidentally overwrite the original article with a mostly blank file.

Now I’m ready to start turning this into a template.

I’d take this article document and delete the actual article content. Start with the

beginning of the actual article text, and stop just short of where it says “The End.”

Where the title is written in all caps and centered on the line, I’d delete that and just write

the word TITLE in all caps and centered. That shows me where to put the title, and how to

format it.

At the top where it lists the word count, I’d delete the actual number and replace it with

x,xxx to show where the number goes

That’s all there is to it—now I have a perfect file for a template. I just need to save it.

Where are Templates Stored?
The default template location can vary from one Linux distribution to another, between

different versions of OpenOffice.org, and of course the Windows version will have a different

location than the Linux version. The best thing to do is launch OOo and see where they are

stored on your PC.

In OOo, click the Tools menu and choose Options.

On the left, under OpenOffice.org, choose Paths. On the right, click Templates and click

the Edit button.

You’ll see one or more paths listed. In a default install of Linux Mint 6, the path marked

as the Default is /home/user name/.openoffice.org2/user/template.

If you want to work with the default, this is the folder where you’ll save the template file.

I prefer not to use this location, because I don’t like storing them in a hidden folder. Since
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one of the levels of the folder name starts with a period (.openoffice.org2), it will be a hidden

folder. So I would create my own folder called Templates, under /home/user name.

Then I go into the options in OOo, to the Templates path and click the Add button. It

brings up a window where I can select the folder. If you haven’t already created the new

Templates folder, you can create it here and then select it. Click OK until you get back to the

document.

Now you can save the file as a template. Click File > Save As.

For the document type, click the drop-down and choose ODF Text Document Template (the

extension is.ott). If you’re doing something other than a word processing document, then select

the appropriate template for that type of file.

Now, give the template a name and select the location where your templates are stored.

Once you save it, that template is now available for you to use.

To create a new document using that template, in OpenOffice.org just click the File menu,

choose New, then choose Templates and Documents. All your templates will be listed there,

including the new one you just saved.

And that’s all there is to creating and using templates.

Other Considerations
When you’re creating a new template, be sure to test it with multiple pages and make sure

your page numbers look the way you want. Some documents have no page number on the first

page, and numbers on all the rest of the pages. If that’s what you’re doing, make sure to test

your template to at least two pages.

Or you might even have three different types of page numbers -- for example, if you have

no number on the first page, and different locations for the numbers on left and right pages.

You’d want to test that template to at least three or even five pages, so that you’d have a first

page, left page and right page.

Once you know the page numbers are coming out correctly, you can delete the extra text

and bring it back down to one page.

If you do need to test it to two or three or five pages, there’s an easy way to enter sample

text in OpenOffice.org Writer. Just type the letters dt and press F3.

This is an Autotext entry that is set up by default in OpenOffice. It will enter 291 words

into your document. The text reads like the beginning of a story—and not a particularly good

one -- but you don’t really care what it says, just that it makes it easy to see how your

formatting would work out with a chunk of text. You can repeat the process if you need to fill

out more of your document.

This DT autotext entry is not in Microsoft Word, which I have to use at the office. But I’ve

found this to be so useful in designing documents that I’ve added this into Word on my work

PC as an Autotext entry.

So, if you create documents in OpenOffice—any kind of document, whether it’s a word

processing file, a spreadsheet, presentation or drawing—templates can make your life easier.

With templates you can save time, save effort, and keep your documents consistent.

Charles Olsen is a writer, trainer and IT professional. He can be reached at charles.olsen

@pobox.com. See more articles at and listen to the mintCast podcast at http://mintcast.org. 

© 2009 by Charles M. Olsen.
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Dozens of PC Utilities Free for the Taking
by Ira Wilsker

APCUG Director; Columnist, The Examiner, Beaumont, TX; Radio Talk Show Host

WEBSITES:

http://tinyurl.com/95free-utilities

http://openoffice.org

http://www.iobit.com

http://www.defraggler.com

http://www.recuva.com

I
read a lot of online computer magazines. Most of them are American, but some are foreign,

including from such diverse places as England, Germany, and Australia. Recently the

Australian magazine PCWorld Australia published an article titled (sic) “95 great free sites

and downloads you’ve probably never heard of” (tinyurl.com/95free-utilities). From the

feedback I have received from readers of this column, there is great interest in totally free

computer utilities, especially in these pressing economic times.

The article categorizes the free software into 12 categories including productivity software,

music utilities, security tools, web enhancers, phone utilities, photo and video managers, social

networking, PC performance enhancements, file synchronization, and business applications.

In the productivity software category, the first recommendation is one of my personal

favorites, OpenOffice. OpenOffice (OpenOffice.org), which was reviewed in this column last

year, is a full featured free office suite that can read and write Microsoft Office files such as

Word, Excel, and PowerPoint, as well as many other formats. With its frequent updates and

enhancements, OpenOffice would be a wise choice for anyone who wants an office suite with

“all the bells and whistles” totally free. The menu hierarchy and appearance are nearly

identical to Word, Excel, and other Microsoft Office products providing for a “near zero”

learning curve for anyone familiar with Microsoft Office products. Other productivity utilities

are displayed including: Flowgram, which can create web-based multimedia presentations;

Gubb, which is a personal time manager; PrimoOnline, which helps you create PDFs without

software; and “Remember the Milk” which helps you to remember to do anything, and

integrates many platforms, including BlackBerry, iPhone, Gmail, and Windows Mobile.

The music utilities category has several programs that I am not familiar with, but appear

to be very attractive, and since they are totally free, there is no downside risk in trying them.

The one rated as a “BEST BET” by the magazine is Songbird, an open-source downloadable

media player that’s completely customizable and packed with innovative features. Songbird

is both a music player and a Web browser that enables the quick downloading of music. Other

utilities listed include “SharePod,” which enabled iPod users to change, backup, or share music

between iPod users.

The security category includes some utilities that I have written about in the past. The one

top rated by PCWorld Australia is the excellent and free Avast Antivirus, which utilizes seven

different “shields” to protect the computer from attack from different sources and vectors.

Avast is one of the most popular free security utilities with tens of millions of devoted users,

and would be a good choice for anyone wanting a free antivirus product that is equal to or

superior than many of the expensive commercial competitors. Other free security utilities

listed are from “a-squared” (previously discussed in this column); “Attack Trace,” which can

detect if a website is under attack; Comodo EasyVPN Home, which allows the user to create
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a virtual private network (also recently discussed in my column); a firewall, and a pair of

excellent anti-spyware utilities. These utilities would all be worthy of consideration as their

quality is generally excellent, and often better than their commercial counterparts.

Most of us use our internet browsers directly as they come from the publisher, unaware

that there are tweaks that are available to improve our online experience. There are thousands

of plug-ins and add-on’s for Firefox, and unknown to many there are also many similar

improvements for Internet Explorer. These plug-ins listed in the magazine article include a

note taker for Firefox, a news reader which is an improvement over the one integrated with

Internet Explorer, a FTP (file transfer) utility for Firefox, a nifty utility “Google Preview” that

displays thumbnail images of web pages that appear in Google search results, IE7Pro which

adds Firefox-like features to IE7, a mapping utility that automatically displays street maps

by clicking on an address, and “Video Download Helper” which is a Firefox plug-in that I use

to download videos from the major video sites such as YouTube. The 11 browser enhancements

listed may add a lot of enjoyment to the web browsing experience.

Being a typical geek, I like to try and tweak the best performance that my computer is

capable of delivering. PCWorld Australia editors and I think alike as we have both written

about some the same free performance enhancement utilities. At the top of the magazine’s list

is one of my personal favorites that I use regularly, Advanced System Care Free, available

from www.iobit.com. This is a full featured performance utility that has dozens of tools to

enhance PC performance, including a registry cleaner, anti-spyware, internet speed-up tools,

and many others. I routinely put this program on almost every computer that I use. Just a few

weeks ago I wrote about free utilities from Piriform, including a unique defragmentation

utility called Defraggler (www.defraggler.com). This utility, which is on my computer, can

quickly defragment files, folders, or an entire hard drive. Recuva (www.recuva.com), also from

Piriform, is a file recovery utility that can undelete files on hard drives, flash drives, and other

forms of media. I have personally used Recuva to restore some photos accidentally deleted

from my digital camera, and it worked fine!

This article can be read online at tinyurl.com/95free-utilities, where dozens more free

utilities can be found. The actual URL of the magazine was much longer (138 characters), so

I used the free online utility TinyURL (www.tinyurl.com) to create a much smaller URL that

would be easier to enter. I hope that the readers of this column will be more aware that there

are some fine free programs out there that are worthy of a chance. I suggest that you try some

of them.

This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (Iwilsker (at) apcug.net).

Things That You Can Do With That Flash Drive
by Ira Wilsker

APCUG Director; Columnist, The Examiner, Beaumont, TX; Radio Talk Show Host

Websites:

http://portableapps.com

http://u3.sandisk.com/download/Download_no.asp

http://www.microsoft.com/windows/windows-vista/features /readyboost.aspx

W
ith the demise of the floppy disk, and the approaching demise of the CD disc for data

purposes, the USB flash drive has become the defacto method of saving and
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transporting files between computers. These small USB drives are known by a variety of

monikers, such as flash drive, pen drive, pin drive, and thumb drive. Since their introduction

a few years ago, their capacity has increased, and their prices have plunged. They are readily

available in the big box stores, discount stores, club stores, and online. The most recent ones

I purchased for the holidays were 8 gig size (almost the equivalent of the data stored on 2

standard DVD discs, about a dozen CD discs, or about 5700 floppy disks), and cost under $15

each. In the after-Christmas sales, some 8 gig flash drives were advertised for $9 each (after

rebate). This amount of non-volatile storage for the price was inconceivable just a few years

ago. I thought I was getting a bargain a few years ago when I bought my first flash drive, a

64mb Lexar, for $49, and now a drive with about 64 times that capacity is about one-fourth

the price! I have co-workers and students who wear their flash drives on cords around their

necks, where they are referred to as “geek beads.”

Most of us use the drive simply for portable storage, the ability to carry files around with

us, but in reality these flash drives can do much more than to simply be used for storage. Most

of the USB flash drives on the market today comply with the USB 2.0 standard for high speed

transfer, while there still are a few inexpensive, low capacity drives that are of the slower USB

1.1 speed standard, or only about 3% of the speed of the USB 2.0 drives. From a practical

viewpoint, the user will not notice any significant difference in speed if small files are saved

and read, but will notice a difference if large files are used.

There are some other standards for USB flash drives that many users may find beneficial,

if their flash drives have the capabilities. Users of Microsoft Vista (Home Basic, Home

Premium, Business, and Ultimate versions) may find it advantageous to purchase flash drives

that are labeled as “ReadyBoost.” According to Microsoft, “Windows Vista introduces Windows

ReadyBoost, a new concept in adding memory to a system. You can use non-volatile flash

memory, such as that on a universal serial bus (USB) flash drive, to improve performance

without having to add additional memory “under the hood.” If the drive is compatible with the

ReadyBoost standard, some of the flash memory in the drive can effectively and temporarily

be added to the RAM (memory) installed in the computer, with an improvement on

performance. If the Vista user with a compatible flash drive right clicks on the flash drive

letter displayed under “My Computer” or Windows Explorer, and then left clicks on

Properties— ReadyBoost, Vista will recommend how much of the available memory on the

drive can be effectively and safely utilized by Vista. Other data stored on the ReadyBoost drive

is protected from damage, and will not be harmed if the drive is used as a ReadyBoost drive.

Because of the higher performance requirements, ReadyBoost compatible flash drives are

slightly more expensive than standard drives, but are often the least expensive way to add

memory to a Vista computer.

Another useful feature often found on a USB flash drive is known as “U3.” Drives that are

U3 compatible are labeled as such. A U3 powered flash drive allows the user to carry special

versions of hundreds of programs on the flash drive that can be run directly from the flash

drive without being installed on the computer. This is an effective way to carry the actual

software the user is familiar with, and run it on other computers. When unplugged from the

computer, U3 leaves no data or other information left on the computer that was used. Some

of the popular programs that come in U3 formats are the Firefox browser, Skype telephone,

McAfee Antivirus (about $15), RoboForm Password Manager, OpenOffice (the comprehensive

suite of office software including a Microsoft compatible word processor, spreadsheet,
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presentation program, database, and more, free), Thunderbird email client, and dozens of

games. Most U3 drives come preinstalled with password protection and a “U3 Launchpad”

which is a menu driven directory of the software on the U3 drive.

For those of us who have standard non-U3 drives, there is now an alternative that provides

for the same functionality. This alternative to U3 that will run on almost all contemporary

flash drives is called “PortableApps,” and can be found online at portableapps.com. According

to the PortableApp website, “A portable app is a computer program that you can carry around

with you on a portable device and use on any Windows computer. When your USB flash drive,

portable hard drive, iPod or other portable device is plugged in, you have access to your

software and personal data just as you would on your own PC. And when you unplug the

device, none of your personal data is left behind.” Dozens of portable apps are available,

including the Firefox browser, OpenOffice office suite, antivirus software, games, password

managers, and many other pieces of software. The PortableApp Suite is totally free, and does

not contain any spyware or adware. In addition to the bundled suite, there are many other

programs available, almost all free, which will run as portable apps. The PortableApp website

keeps a running tally of new software that is available, including new releases and versions,

as well as beta (pre-release) software. A simple click will install the selected software on the

flash drive.

Now that many of us are routinely carrying flash drives, it is nice to know that they may

be capable of doing much more for us than just transport data.

This article has been obtained from APCUG with the author’s permission for publication by APCUG

member groups; all other uses require the permission of the author (Iwilsker (at) apcug.net).

My PayPal Account’s Been Hacked
by Steve Bass

T
he e-mail from PayPal said I’d sent $400 to a gaming firm in Germany. It’s a dopey

phishing expedition, I thought, and authentic-looking, for sure, but nothing to worry

about. 

The trouble was that when I logged on to PayPal, I really did have a $400 withdrawal. It

was clear that someone had my password. 

Quick Password Tips 
Here are the three essential things you need to know about password security: 

C Use a password generator, a program that will create a long, complicated password. 

C Don’t ever use dictionary words, even if you stick in symbols, like bill$gate$. They’re

very easy to break using simple hacker programs.

C Use a different password for every important site. Using the same password on every

site, especially critical ones, such as banking, is risky. Imagine using your one

password on an unsavory, and possibly unscrupulous site. With that golden password,

and a few guesses on your login name—stevebass, steve_bass, sbass—and they’re in

like Flynn. 

Who’s Got My Password?
 I contacted PayPal (888/221-1161), supplied the details, and they opened up a case. My

account is frozen and I don’t doubt PayPal will credit me for the loss. (As I started editing this

newsletter, PayPay reversed the charges.) PayPal is investigating, but I don’t think they’ll ever
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find out how someone got into my account, though it was clear the person had my password.

The rep said I probably fell for a well-crafted e-mail spoof. 

That’s a blow to my ego. I see myself as suspicious—verging on paranoid—when it comes

to phishing e-mails. What better prize than bragging rights to hacking a PC World guy, right?

So I’m as vigilant as my dog is when I try to get her to take a pill wrapped in peanut butter.

(Hey, you can’t fool me, pal, she probably thinks...) 

If an e-mail—suspicious or not—refers to any of my important accounts and provides a link

to click, I ignore the offer. It’s safer to manually type the URL into my browser’s address field.

And yes, I’ll cover phishing hassles—and ways to guard against it—in a future newsletter.

Password: z24x680uBS4!44 

I’m also careful with my passwords and, at least until now, thought they were super

stealthy. For example, on PayPal I used four numbers, a symbol, and three letters. According

to Microsoft’s Password Checker, my standard password pattern—1600%wtf—is strong. But

it could be better. 

Microsoft says that the most effective passwords are 14 characters and have a combination

of upper and lower case letters, numbers, and a symbol or two. For example, z24x680uBS4!44

is strong enough for them to call it “best.” 

Test your passwords on Microsoft’s site and see how well they stand up. Then browse

Microsoft’s excellent Strong passwords: How to create and use them. I promise you’ll learn

something. <http://tinyurl.com /2e7tmw>

Use Microsoft’s Password checker to test your password’s strength. You might be

surprised. <http://tinyurl.com/ypc3dc>

Generating Strong Passwords
Creating a strong password is easy, provided you don’t try to think one up on your own.

There are dozens of Web sites that’ll create passwords, but I don’t use any of them. The last

thing I’ll do is trust someone online watching me create new passwords. Instead, download

Password Generator, a freebie, and crank out all sorts of 14-character passwords. 

Create a strong password with this freebie. <http://tinyurl.com /4j8e8>

Keeping Track of Your Passwords
I just looked and counted roughly 220 sites I use that require a password. 

Some site passwords, however, are immaterial. For instance, I use a simple-to-remember

word for spots I rarely visit, places such as newspapers that force you to register and log in

just to read articles, or tech sites with forum messages. 

However, ever since the PayPal fiasco, I’ve changed every significant password on my

system to a 14-digit gorilla. 

Remembering all those passwords is a PITA, so you ought to consider using a password

management tool. There are lots available. Many people like KeePass, a freebie; others swear

by LargeSoft’s $30 Password Manager. I anticipate easily 100 e-mails—no make that

200—kvetching that I haven’t mentioned your favorite. But as far as I’m concerned, RoboForm

is the best one around, and I’ve used it since it was first introduced. 

RoboForm, The Master at Passwords
RoboForm is a $30 program with more features for password management, privacy, and

password identification than any other program I know. You provide RoboForm with all the

vitals you might need to complete a site’s form—name, address, phone numbers, and even



-11-

credit card numbers. When you click the Fill Forms button, the program does just that. I’ve

created multiple identities, each with different info. For instance, I have one with MasterCard

info, another with VISA accounts. I have another identify I call “anonymous” that I use to fill

in forms on sites that I’ll never visit again. 

Enter data into RoboForm’s Identity card and fill in online forms. 

Click a Web site from the RoboForm Passcard screen, and RoboForm transports your Web

browser to the site, logging you in if necessary. Need an industrial-strength password?

RoboForm will generate one for you. And don’t worry about security: RoboForm is itself

password- protected. The program will also safely send an encrypted password through e-mail

to another RoboForm user. (I was recently discussing with my wife the fact that neither of us

can function without it.) RoboForm’s Passcard logs you in and inserts your password. BTW,

RoboForm foils keyloggers (programs that watch keystrokes) because instead of typing,

RoboForm inserts characters into form fields. 

Here’s a summary of RoboForm’s features, <http://www.roboform.com/features.html> a

comprehensive FAQ <http://www.roboform.com/faq.html> with answers to your most technical

RoboForm questions and a way to compare the free and Pro versions

<http://www.roboform.com/why-pro.html>. 

If you need portability, RoboForm2Go gives you the same protection when you carry your

passwords on a flash drive and use it outside the office. Both the RoboForm program and your

password files reside on a USB key, so you can take them from one computer to another. The

tool costs $40, but if you buy it at the same time you get RoboForm, the price drops to $20. If

you dig around, you’ll occasionally find discounts. (Google RoboForm discount.) 

Siber Systems offers a 30-day trial of both products. They work in all versions of Windows

and support IE and Firefox, but not Google Chrome, Opera, or a few other browsers. Take a

look at the compatibility list <http://www.roboform.com/browsers.html>. 

There’s lots more to say about password management, but I’m almost out of space. So while

you’re hot on the topic, read Bitmill’s smart series of Password Security 101 articles. They’re

less basic than you might imagine <http://www.thebitmill.com/articles/>

This article originally appeared in Bass’s TechBite newsletter. Supscribe to Bass’s free newsletter

and read his blog at www.snurl.com/techbiteblog. Contents copyright 2009, TechBite, LLC. This article

has been obtained from APCUG with the author’s permission for publication by APCUG member

groups; all other uses require the permission of the author.

How to Spot-phishing Email

there are many telltale signs of a fraudulent email

1
. Sender’s Email Address. To give you a false sense of security, the “From” line may

include an official-looking email address that may actually be copied from a genuine one.

The email address can easily be altered—it’s not an indication of the validity of any email

communication.

2. Generic Email Greeting. A typical phishing email will have a generic greeting, such as

“Dear User.” Note: All PayPal emails will greet you by your first and last name.

3. False Sense of Urgency. Most phishing emails try to deceive you with the threat that your

account will be in jeopardy if it’s not updated right away. An email that urgently requests you

to supply sensitive personal information is typically fraudulent.
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4. Fake Links. Many phishing emails have a link that looks valid, but sends you to a

fraudulent site that may or may not have an URL different from the link. Always check where

a link is going before you click. Move your mouse over the URL in the email and look at the

URL in the browser. As always, if it looks suspicious, don’t click it. Open a new browser

window, and type https:// ww.paypal.com/us.

5. Attachments. Similar to fake links, attachments can be used in phishing emails and are

dangerous. Never click on an attachment. It could cause you to download spyware or a virus.

PayPal will never email you an attachment or a software update to install on your computer.

Dear User.

We’ve tried to contact you severs! times and to this date, have not heard back from you.

If we don’t hear back from you with 24 hours, YOUR ACCOUNT WILL BE DISABLED.

Click Here to access your account

htlp:/Awww.?????.corn/cqi-bin/account?update

how to spot a spoof (fraudulent) website

A phishing email will usually try to direct you to a fraudulent website that mimics the

appearance of a popular website or company. The spoof website will request your personal

information, such as credit card number, Social Security number, or account password.

You think you are giving information to a trusted company when, in fact, you are supplying

it to an online criminal.

1. Deceptive URLs.

Be cautious. Some fraudsters will insert a fake browser address bar over the real one,

making it appear that you’re on a legitimate website. Follow these precautions: Even if an

URL contains the word “PayPal,” it may not be a PayPal site.

# Examples of fake PayPal addresses:

- http://signin.paypal.com@io.it).32.4/

-http://8^.i6.i2^.i8/pp/update.htm?= https://www.paypal.com/=cmd_ ogin_access

- www.secure-paypal.com

# Always log in to PayPal by opening a new browser and typing in the following:

https://www.paypal.com/us.

# The term “https” should precede any web address (or URL) where you enter personal

information. The “s” stands for secure. If you don’t see “https,” you’re not in a secure

web session, and you should not enter data.

2. Out-of-place lock icon

Make sure there is a secure lock icon in the status bar at the bottom of the browser

window. Many fake sites will put this icon inside the window to deceive you.

Thanks to PayPal for posting these tips. You can find more about phishing and fraudulant websites

at <https://www.paypal.com/us/cgi-bin/webscr7cmd-xpt/Marketing securitycenter/general

/RecognizePhishing- outside>.

How to Make Windows XP Shut Down Faster
by Tina Gasperson

Tiplet

W
hen its time to reboot your computer, it can be frustratingly slow sometimes to wait

out the reboot, especially if you need to use your system. There are a few things you

can do to help speed up the process, though.
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One fun and efficient thing you can do to speed up your shut down is to create a “Restart”

shortcut. Pull up your desktop screen and right click anywhere on it. Put your cursor on “New”

and then click on “Shortcut.” In the text entry window that appears, enter the following

exactly as shown:

shutdown -r -t 00

Click “Next,” and enter a name for your new shortcut. Something like “Restart” or “Reboot”

would be appropriate to avoid any nasty surprises later on. Now you can select an icon for your

shortcut if you like. Right click on it and click “Properties.” Click on the “Shortcut” tab and

then click on the “Change Icon” button. Find the icon you like, select it, and click “OK,” then

“OK” again.

Reboot Windows XP
Another way to speed up reboots is to force Windows to immediately shut down any open

applications, instead of waiting or asking you if it is really ok to do so. Be careful with this

option, because if you have any unsaved files open you will lose them in the reboot. As long as

you remember to frequently save open files, you’ll be ok. To make this change, click “Start,”

“Run,” and type regedit in the text entry box. Click “OK.” Double click on “HKEY_CURRENT_

USER,” then “Control Panel,” then “Desktop.” On the right side of the window, scroll down

until you see “WaitToKillAppTimeout.” Double click that, and change whatever is in the text

entry box to 0 and click “OK.” Now find “HungAppTimeout,” double click, and change the

number in the text entry box to 0. Click “OK.” Find “AutoEndTasks,” double click, and change

the number in the text entry box to 1. Click “OK.”

Now, go back to the left side of the window and find “HKEY_USERS,” then “DEFAULT,”

“Control Panel,” “Desktop.” On the right side of the window, find and double click “WaitToKill

AppTimeout” and change the value to 0. Click “OK.” Find and double click “HungAppTimeout.”

Change the value to 0. Click “OK.”

Finally, tell Windows not to hesitate on shutting down services. In your registry edit

window on the left side, look for “HKEY_LOCAL_MACHINE,” then “System,” then

“CurrentControlSet,” then “Control.” On the right side of the window, double click on

“WaitToKillServiceTimeout” and change the value in the text entry box to 0. Click “OK.” Exit

the registry editor.

Now when you double click your shortcut, the computer will reboot faster.

Tina Gasperson (tinahdee@gmail.com), affectionately known as Computer Lady by her family, has

been writing about IT, home computing, and the Internet for more than a decade. This article was first

published at Tiplet.com, a web site offering expert tips and tech support for Windows, Mac, and Linux—

visit to subscribe to their free newsletter.

How To Recover Deleted Files - For Free
by Bob Rankin

R
ecover deleted files - Recycle Bin So you lost an important file. Ouch. If you simply

deleted the wrong file, you can usually get it back by opening the Recycle Bin and

restoring it. But if that doesn’t do the trick, try one of these free tools to do the heavy

lifting. Read on and you’ll find a crop of Windows- based tools to recover deleted files.

Recover Files 2.1 <http://www.undeleteunerase.com/> is a free professional software tool

that allows you to recover data removed from your hard drive, recycle bin, portable devices or

even a compact flash drive. This Windows- based utility is compatible with 95/98/Me/NT
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/2000/XP/2003/Vista and will recover lost files from all NTFS and FAT partitions with a simple

interface. The award winning software has recently been updated to repair some bugs and

added 11 languages. Register on their site before downloading.

Piriform’s Recuva

<http://www.recuva.

com/> (pronounced

like “recover” with a

Brooklyn accent) will

help you to find files

and images on your

computer that were

deleted by human

error, including those

deleted from your

digital camera mem-

ory card or MP3

player. Recuva can

also restore files de-

leted from the recycle bin or those that were deleted by a bug, virus or crash. This is a free

Windows application that includes a support forum and because it is a freebie, Piriform would

appreciate a small donation if you like their software. Recuva comes from the same people that

developed the popular CCleaner, so the reputation is rock solid.

One of the most popular free file

recovery tools for Windows is Resto-

ration <http://download.cnet.com

/Restorat ion /3000-2094_4-

10322950.html>. This program will

find just about everything you’ve

ever deleted from your PC, includ-

ing files deleted from the DOS

prompt. When the program starts,

choose a source drive, then click the

“Search Deleted Files” button. If

you have a file on your hard drive

with the same name, restore the file

to a different folder, or flash disk so

that your existing file is not wiped

out. Restoration can also permanently delete files, making it almost impossible to restore or

undelete them. Restoration has a no-frills user interface, but it’s easy to use and does a good

job.

FreeUndelete <http://www.officerecovery.com/freeundelete/> has no charge for personal

usage, although they charge for businesses. The program is spyware and adware free, works

on Windows XP, 2000, NT4 , Windows 2003 Server, and can restore files from your Recycle Bin

or NTFS, FAT32 or FAT16 hard drives. Once recovered, they will be saved in a new

user-selected location to prevent overwriting files.
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There are also free tools for other PC catastrophes. Advanced PSD Repair (APSR)

<http://www.officerecovery.com/freeundelete/> is handy for recovering Photoshop PSD and

PDD files and works with all versions.

And if you work with external media, Recovery Toolbox for CD Free <http://www.recoverytoolbox.com/cd.

html> can recover data from damaged or corrupted CD, DVD, HD-DVD and Blu-ray discs. The

same company also makes a variety of other data recovery tools, including Recovery Toolbox

for Outlook, Outlook Express, Word, Excel, Zip and other applications to recover damaged or

deleted data. They’re not free, but you can get a free trial to see if it’ll do the job.

Do it Now...

Obviously, all of these tools are most useful if you install before you lose the data, because

downloading a file can possibly overwrite the very file(s) you want to recover. I recommend

that you check out a few and download them, so you’ll be ready in case you do need to recover

lost files. 

From The InternetTOURBUS Vol 14, Number 17, dated 12 May 2009, Subscribe at

http://internettourbus.com/

The Perils of Remote Access
Q. The person who recently repaired my computer set it up so he will be able to remotely fix

problems in the future by taking control of my PC. My question is this: Am I exposing my

personal financial information to him, even if it’s on a memory stick in the USB port of my computer?

A. When you provide remote access to your computer, you are giving carte blanche access to

your system. Any data on your hard drive is accessible, as is data on a floppy disk, zip disk,

connected external drive, or memory stick in the USB slot. It’s truly no different than if your

repair person sat down at the keyboard and used your computer. 

As long as you have full faith and confidence in your computer-repair person, you should

be fine. But if you don’t want him to have access to certain data, you’ll need to remove it from

your computer. For example, if you have the data on a memory stick, simply remove it from

the USB port. 

Having said that, most computer repair folks are honorable people who do not make a

habit of rummaging through data—but they certainly could if they were so inclined. As a

matter of protocol, remote access should never be implemented without your permission, as

owner of the computer.

Q. Your weekly newsletters have helped this old mind become more computer literate, so

thank you for that. My question is this: I had a dial-up connection at one time, but I am now

using DSL service. My problem is that the dial-up box continues to appear, sometimes

knocking me off a Web site I’m visiting. Can you help me? I’m using Internet Explorer.

A. Your computer is still trying to connect to the Internet by dialing. You can resolve that by

opening Internet Explorer and clicking Tools > Internet Options > Connections tab. Click to

select the setting that says “Never dial a connection,” then click OK to save your changes. That
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will prevent the pesky prompt from popping up in the future. 

Q. How can I stop addresses from being automatically added to my Outlook Express address

book? Thanks for your help, Mr. M. 

A. There is a setting in Outlook Express that automatically adds people to your address book

when you reply to a message. To disable this feature, open Outlook Express and click Tools

> Options > Send tab. Click to remove the check mark beside “Automatically put people I reply

to in my Address Book,” then click OK.

Q. I know this is way out of your field, but I’m working on a sewing project and I need to know

how to make a continuous bias strip for covering cords. Is there somewhere online I can look?

A. I don’t even know what a continuous bias strip is, but thanks to Google (www.google.com),

even a stitch-challenged person like me can find the right answers. Using Google, I searched

for “How to create continuous bias strip.” Of the search results that appeared, <http://

tinyurl.com/2edtaz> and <http://tinyurl.com/cvko4m> look particularly promising. You might

also want to run similar searches on YouTube (www.youtube.com) and WonderHowTo

(www.wonderhowto.com) for video tutorials. 

Google is a remarkable search tool that is under utilized by most users. If you familiarize

yourself with its advanced search features and techniques, you’ll be able to find just about

anything and very quickly. The GoogleGuide (http://tinyurl.com/apzkr) is a search enthusiast’s

dream-come-true, combining Google’s many features in one suitable-for-laminating cheat

sheet.

Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month

The Diaries of John Quincy Adams

It sounds like a snoozer, but it’s really not. Here you can learn about the fascinating life

of America’s sixth President. The site contains a complete digital collection of Adams’ personal

diaries, which he began in 1779, when he was 12. Diaries can be searched by volume, date, or

selected pages of his 51 volumes, comprising 14,000 pages—which begs the question: When

did he have time to do anything else?

www.masshist.org/jqadiaries

Hairstyle Gallery

Say goodbye to those dog-eared hairdo magazines at your local salon; it’s time to hairness

the power of the Internet to select a new hairstyle. Browse the Hairstyle Gallery, which

contains thousands of photos of well-coiffed individuals. Search by color, texture, style,

celebrity, length, face shape, or in my case, “Where did it go?” (I don’t care what anybody says,

I’m not losing my hair; I’‘m getting prematurely pink.)

http://hairstyles.hairboutique.com

World-O-Meter

Statistics about population growth, the environment, and other large-scale topics can be

difficult to grasp. The World-O-Meter tracks statistics, some frightening and some amusing,

such as the Earth’s current population, the rate of forest loss, the number of bicycles produced

annually, the amount of money Americans spend on perfume, and many others.

www.worldometers.info

For plain-English answers to your questions by email, plus great computing tips, subscribe to Mr.

Modem’‘s award-winning newsletter. Subscribe using Promo Code 1640 and receive TWO free months

with your 12-month subscription (60 issues!) To view a sample issue or subscribe, visit www.MrModem-

.com. 
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From The DealsGuy
by Bob (The Cheapskate) Click

Greater Orlando Computer Users Group

I
was reading the Orange County IBM PC Users Group newsletter (nibbles & bits) and

noticed an interesting article. Linda Gonse does a great job of editing this great newsletter

and those of you who don’t get to read it are missing a real treat. I don’t own an iPhone,

but many of my readers do. Lorene Romero, North Coast Macintosh Users Group President

(in Santa Rosa, CA), wrote the article about some unique items available for iPhones. Three

that I found interesting are quoted below with Lorene’s permission:

“Coffee Break: $1.99 (****): Great app for those who love coffee! It has a very ‘fun’ interface

with appropriate company cups. It has the usual suspects (Starbucks, Pete’s and Seattle’s

Best), but it also has a category for ‘Other Coffee Places.’ It is a great app if you are a coffee

hound, like I am. The seller is Marco Pifferi”

“AroundMe: Free (****): Cool little app that lets you find banks, coffee places, gas stations,

supermarkets, and even an Apple store, located near you. First it finds your location and then

accesses a database filled with local shops. I used it in Seaside, OR and found a wonderful

coffee shop right down the street.”

“Say Who Free (****): Finally an app that brings back voice activation to the iPhone! Say

any name (Jon Jones Mobile) and it will dial it every time for me.”

You can download these from the iPhone store: <http://www.apple.com/itunes/whatson

/appstore.html>

Why Not Scrap The Crap?

One of the Vendors at the FACUG/APCUG Florida spring conference was Sunbelt

Software. They offer Vipre Enterprise. They call the product a non-bloated antivirus,

antispyware, and antirootkit software that includes other technologies to make it an all-in-one

protection. They say it offers Real-Time Monitoring with Active Protection. Removing rootkits

is supplemented by VIPRE’s FirstScan™, which runs at the system’s boot time. FirstScan

bypasses the Windows operating system to directly scan certain locations of the hard drive for

malware, removing infections where found. They say Vipre’s Active Protection delivers real

time monitoring and protection against known and unknown malware threats. Active

Protection works inside the Windows kernel, (the core of the operating system), watching for

malware and stopping it before it has a chance to execute on your system.

VIPRE includes comprehensive protection against e-mail viruses, with direct support for

Outlook, Outlook Express and Windows Mail; and support for any email program that uses

POP3 and SMTP. In reading their product information, I found more good information on the

product than I could possibly include in this column, so please visit their Web site and look it

over carefully for full information. <http://www.sunbeltsoftware.com/Home-Home-Office

/VIPRE/>.

This company is not based on some small Pacific atoll, or some strange sounding name of

a country you never heard of, but is located in Clearwater, Florida where their tech support

will speak good English (maybe Spanish if you need that) if you need to talk to them. Trip

Kirk, Sales Engineer for Sunbelt Software, said they’ll offer user group members the following

coupon code (DealsGuy) that’s good for $5 off of any Vipre consumer license through August

31, 2009 at <http://shop.sunbelt-software.com/licensing.cfm?product=VIPRE>. Trip says that



-18-

can be a single license, a two-computer license, or even the unlimited home license, which is

good for as many computers as someone has at their one home address; or if they have

computers in Florida and also in another state, such as snowbirds can, they can use it for all

of the computers that they personally own. I guess that being surrounded by seniors in

Clearwater has influenced them favorably.

For what it’s worth, I realize that you can instantly name at least six places to find FREE

protections of all types, but it can also be said that “you get what you pay for?” Just about

every free protection product also offers a pay version with added features that they hope

you’ll buy later on to give better peace of mind. Here you get the peace of mind right up front.

I have not had the chance to try this product.

What’s This, A Photo Production Line?

Bits&Coffee has released BatchPhoto V 2.5, a powerful Windows photo manipulation

program that makes it easy to annotate, touch up, transform, apply effects, convert, and

rename hundreds of pictures in a single operation. BatchPhoto lets you select a group of

images, define a series of edits, and apply them in a single operation rather than individually.

With version 2.5, BatchPhoto introduces Raw Photo Development. DSLR digital cameras

can save the raw image data as read by the optical sensor without any loss or additional

processing. The resulting files, often called raw images or digital negatives, need additional

processing on the PC with specialized software. Almost every digital camera manufacturer has

one or several different file formats for storing the raw image data, which leads to poor

support from software vendors. BatchPhoto can read and convert most of those formats,

including formats from digital camera makers like: Canon, Nikon, Sony, Olympus, Fuji,

Kodak, or Pentax.

By taking advantage of multi-core processors, BatchPhoto can convert hundreds or even

thousands of raw images to common image formats like JPEG or TIFF in a single session.

Custom defined settings, like White Balance or Demosaicing, allow the user to control the

development process in detail. Additional filters and transformations can be applied to photos

in the same session (e.g. Watermark, Resize, Sepia and so on).

BatchPhoto can convert the raw images to dozens of image formats, including: JPG, TIF,

PDF, PNG, GIF, BMP, EPS, TGA, and PSD. It can also change the meaningless names

assigned by digital cameras to custom keyword based names, in the same operation. A second

new feature is the ability to create PDF documents from multiple images. In the same process

each image can be annotated, watermarked, and adjusted.

Overall, BatchPhoto has more than three-dozen graphical filters that can be applied to

pictures. The filters are divided into four main categories; Annotate, Touch Up, Transform,

and Effects. BatchPhoto adds itself to Windows Explorer’s contextual (right-click) menu, so

the user can apply predefined, or custom defined profiles to groups of pictures with ease.

BatchPhoto V. 2.5 runs under all versions of Windows, including Windows Vista and

Windows Server 2008. Home version is priced at $29.95 (US), and Pro at $59.95 (US). User

group members get a 40% discount on the purchase of BatchPhoto by using the discount

coupon 5A1398E4 when ordering, and it’s good through June 2009. <http://www.batchphoto

.com/>.

How About Better Efficiency

Almeza Company has announced LeaderTask Company Management 6.4, a smart solution

for managing employees’ projects, processes, company documents, and relations with clients.
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Designed to facilitate and streamline workflow, the system offers essential tools for managing

task assignments, scheduling appointments, tracking project status, evaluating employees’

efficiency, and many more.

To save time and effort, LeaderTask Company Management has been developed. The

system provides advanced workflow management capabilities, storing the information on all

tasks, projects, and appointments and delivering it in the convenient form. The software

doesn’t require a server and works via Internet or LAN. LeaderTask provides each user with

an organizer and can serve as a task planner, personal information manager, calendar, project

manager and contact manager, allowing the user to add tasks, contacts, notes, links, projects

and categories.

LeaderTask PDA Organizer is a mobile version of LeaderTask for Windows Mobile.

LeaderTask PDA allows having an instant summary of tasks by projects, contacts, and

categories on the pocket computer. At the same time, it’s easy to quickly add new tasks and

make notes. The program features customizable filters with flexible viewing options. A user

can easily sort and filter projects and tasks by key elements and tags such as due date,

priority, employee, project, and category, etc.

LeaderTask Company Management requires MS Windows 2000 or higher and costs $69

for a workstation license. User Group members will get a 10% discount. Further information

on the product, as well as its free evaluation copy is available from <www.leadercommand

.com>. To order with the discount, e-mail them at <ivan.abramovsky@almeza.com> because

I haven’t gotten a response to my request for instructions. Also, with a minimum of five

workstations per order, look the pricing over carefully if you are interested.

That’s it for this month. I’ll have some more new product announcements on my Web site

that didn’t offer discounts. Meet me here again next month if your editor permits. This column

is written to make user group members aware of special offers or freebies I have found or

arranged, and my comments should not be interpreted to encourage, or discourage, the

purchase of any products, no matter how enthused I might sound. Bob (The Cheapskate) Click

<bobclick at bellsouth dot net>. Visit my Web site at <http://www.dealsguy.com>\

Uh oh – I’ve Lost the Manual for a Gadget/Device
by Gabe Goldberg, Computers and Publishing, Inc.

U
nless you’re a compulsive packrat—and can prove it with multiple neatly organized file

cabinets—you’ll eventually find that a gadget or appliance has separated from its

operating instructions. And unless it’s something brick-simple with just On/Off

buttons, or you’ve memorized its every esoteric function, you’ll be baffled and frustrated.

Even worse, many products now come with one-page pictures-only “Quick Start”

instructions showing how to plug them in or insert batteries, turn them on, and not much else.

Perhaps a real manual was delivered on a now-missing CD or a now-forgotten Web URL was

given as a clue for help.

Don’t despair! Many manufacturers offer full manuals on their Web sites, easily located

and perused online or downloaded for printing or offline reference.

Start your quest by guessing or Googling the manufacturer’s Web site. For example,

Googling Oceanus—my watch manufacturer—finds the <http://www.oceanus-us.com/> correct

Web site first out of 3,400,000 hits! Clicking Support and then Manual Information takes me

to a selection page for watch models. Of course, Googling “oceanus manuals” would have taken
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me directly to the same selection page, and including the specific watch model would have

further refined search results. And as a bonus, the manual downloaded from the Web site is

much more convenient to read printed on 8.5"x11" paper than the nasty included-in-watch-box

version with more than a hundred 3.5"x2" pages!

Similarly, instructions for operating my bargain-basement digital voice recorder are

instantly found by Googling “olympus VN-1000se” as is the manual for my recently acquired

external hard drive, by simply Googling model number wd5000ml-00 (which also finds the

Quick Install Guide, Product Specifications, and Frequently Asked Questions (FAQ). 

Happily, manufacturers often put online manuals for older products sold before Web

research was common. And don’t give up if you can’t find what you need—click a Support or

Contact Us link and politely ask about documentation availability. Material is often available

by special request—sometimes free, sometimes for a minimal fee. Don’t begrudge paying for

a manual—if it lets you continue using something, it’s a bargain compared to buying a

replacement!

How Can I Access Windows Desktop Icons

 Without Minimizing All Open Apps?
by Gabe Goldberg, Computers and Publishing, Inc.

P
eople’s computer desktops vary as much as their physical desktops do. Some have just

a few icons while others are crowded landscapes resembling a video game maze.

My PC desktop has the usual software icons plus various files and Web pages I’ve

stashed there temporarily. If I accumulated files there I want to save, I’d never find anything

in the clutter, so I tidy it every now and then.

In the meantime, I use Desktop icons to launch programs and open files, since I find that

easier than navigating Start/AllPrograms to find the right folder, then carefully navigating

to find the right program icon (since I’d hate to run an uninstaller when I meant to run a

program!).

But even with Windows’ Show Desktop button or a mouse button set to Minimize All, it

would be tedious to keep viewing the Desktop to find Desktop icons. So I’ve enabled a standard

Windows toolbar which gives me one-click access to everything on the Desktop WITHOUT

viewing the Desktop!

To do this, Right Click in an empty part of the Taskbar, pick Toolbars, and click Desktop.

The word “Desktop” will appear on the Taskbar, next to the symbol “>>.” When you click the

>> you’ll get a vertical pop-up showing all Desktop icons—program, file, folder, etc. Click what

you want and it will open, and the pop-up list will disappear.

So with minimal mouse movement and two clicks, you’re running your app or looking at

your file, and all your carefully arranged applications are just as you want them. If you select

a folder on the Desktop, you’ll get a fly-out listing of files (or embedded folders) it contains. If

the list won’t fit within your screen height, you can scroll down (and back up) with small black

arrows at the list’s top/bottom.

Note that unless you’ve tinkered with them, Desktop icons are arranged in two separate

alphabetically arranged groups. The first group is items in the All Users Desktop folder; the

second group is items in the Desktop folder for the user you’re logged on as. If you’re slightly

compulsive, it’s easy to open both folders in Windows Explorer and merge the lists. But it’s

equally easy to get used to the two separate lists, since—especially for launching pro-
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grams—you’ll likely click the same few icons most often.

If you like the Desktop toolbar, explore Windows’ other standard-but-usually hidden

toolbars: Address, Windows Media Player, Links, and Language Bar. QuickLaunch is usually

displayed. But enabling more than one or two of them may crowd the task bar so badly that

open program buttons are too small to be usable.

If that happens, uncheck Lock the Taskbar (you did notice that option after Right Clicking

the Taskbar, didn’t you?), grab the Taskbar’s top edge (assuming the Taskbar is at screen

bottom), and slowly lift it enough so that the Taskbar doubles in height. Lock it while you

explore its new shape and components. And don’t worry—everything you’ve done is easily

reversed.

Q: How can I keep from losing gadgets like remote controls?
A review by Gabe Goldberg, Computers and Publishing, Inc.

E
yeglasses case, TV remote control, car keys, cat. Where is it? Things we have—animate

or inanimate—sometimes take on a life of their own and do NOT cooperate by appearing

when they’re wanted.

We can’t tie strings to them all, and blaming one’s spouse for their disappearance is only

briefly satisfying. So http://www.loc8tor.com>, a small gadget that finds what’s missing, is

handy to have around.

Loc8tor provides two kinds of small homing tag and two handheld locating devices which

work like modern-day dowsing rods. The tags, attached to valuables, signal the devices from

up to 600 feet away. The fancier device (pocket-sized Loc8tor Plus) has a small radar screen

which displays lines pointing towards a missing tag; it can handle up to 24 tags. The lesser

device (credit card-sized Loc8tor Lite, handles four tags) uses a row of lights and a beeping

tone to signal when it’s pointed towards the tag; more lights lit and faster beeps shows the

device’s excitement at pointing in the correct direction. Using either device, when you get

close, the tag’s blinking light and chirping brings you in for the finish.

The Mini-Homing Tag can be found by either Loc8tor; the Loc8tor Plus can sound an alert

if a tag goes beyond a settable distance away—useful for keeping children or pets within a

comfortable range. The Panic Homing Tag includes a button which sounds an alert on the

Loc8tor Plus—giving parent and child, or caregiver and patient, a simple and fast way to

communicate an urgent message.

The tags are just a bit too large to mount on eyeglasses. That would require a rice-grain

size item and the manufacturer simply can’t—yet—fit battery, antenna, radio, light, and

beeper into something that small. And I’ve not yet convinced my wife that wearing a tag as an

earring would be a pleasant fashion accessory, while letting me locate her in our house and

yard.

But aside from those minor limitations, it’s a great tool for avoiding tedious searches. True

story: Such a device once found my keys in the pocket of a heavy winter coat I was wearing,

saving me the trouble of wandering all over the house and THEN looking in my pockets.

Depending on construction material, the signal works through walls and floors and can locate

a car in a parking garage—though likely only on the correct level. Testimonials describe use

with pets, model airplanes, toys, and even for construction and running cables. 

Loc8tor Plus Pack (locating device, three Mini-Homing Tags, one Panic Homing Tag) costs

$170; Loc8tor Lite costs $80 (locating device, two Mini-Homing Tags).
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Windows XP and Windows 7
from Dave “Bytes”

I
f you thought Microsoft was going to dump Windows XP completely, think again.

Windows 7 is approaching its official release date not too long from now, and this week

Microsoft unveiled one of the “secret” technologies that will ship with Windows 7

Professional, Enterprise and Ultimate.

Called XP Mode or XPM for short, the new feature essentially virtualizes the legacy

Windows XP operating environment within Windows 7. That is, users will be able to install

all applications that were previously only fully working with Windows XP, on their Windows

7 desktop without having to resort to a dual-boot solution.

Indeed, Windows 7 comes with “compatibility mode” but XPM isn’t the same. XPM is

actually built on the same platform as Microsoft’s Virtual PC 7 product. This isn’t the same

as running an XP environment through a hypervisor. It was previously believed that XPM

would be a Hyper-V client for Windows 7, but it is not.

However, XPM will utilize virtualization technologies in recent processors from both AMD

and Intel, such as Intel’s VT.

Users will be able to install a Windows XP application, and launch it seamlessly on the

same Windows 7 desktop, along side Windows 7 versions of the same application, without

actually affecting the core operating system. This fact alone, allows Microsoft to continue to

support Windows XP in a virtualized environment, thereby giving legacy support without

actually building loads of legacy code into Windows 7. This not only improves Windows 7's

stability and speed, but also security.

At this time, Microsoft is claiming that XPM provides near perfect Windows XP

compatibility within Windows 7.

Microsoft will include a full license of Windows XP SP3 with every copy of Windows 7

Professional, Enterprise and Ultimate for use with XPM.

Society News

May Planning Meeting
by Sharah Blankenship, Secretary

S
teve Staub led the Planning meeting held at Sally Springett’s house, May 5th. Others

in attendance were Bob Avery, Tony Dellelo, Mike Lavelle, Sharah Blankenship, Sally

Springett, and Dan Rothfuss.

The April meeting was discussed, and the presentation and ensuing discussion were

interesting and successful. 

The June meeting will NOT take place at the Brighton Library; it will be at the Penfield

and begin at 6:30, as normal. Anyone who wishes to is encouraged to bring goodies. The July
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meeting will take place at the Pittsford Town Hall, which is a new location for us. There is a

parking lot at the rear of the town hall and the meeting room can be reached through the back

door.

Newsletter printing has been relatively successful, although one member has found a new

way to create PDF’s which may enable the print assembly team to function faster and more

efficiently. The printing is, as always, on the Saturday following the meeting at St. Stephens

from 9-2. 

Changes in bulk mailing rules through the post office may change our ability to produce

and mail the newsletter. The changes are reported to take place in September, and may force

our newsletter to be categorized as a periodical. This change will make mailing the newsletter

a financial hardship on the club. The board is working on alternative solutions for this issue,

including emailing newsletters. As we obtain more information about this issue, we will

discuss it with the club. 

Welcome to any new members. If you are an existing member, please be sure that your

dues are paid, as several members dues’‘ are overdue by more than three months. Please see

Steve if your membership is overdue. Also, if you use the paypal account available on the

rcsi.org website, please send an email to Steve Staub letting him know how you have paid.

For this year’s picnic meeting, the lodge has been reserved for the Brighton Town Park, 777

Westfall Rd. Brighton, NY 14620. Please sign up for the dish/dishes you will bring as soon as

possible. There will be a $5 ticket charge per person to cover the cost of meat and plastic ware.

The Board would like to ask the members to begin planning for the Silent Auction now.

Please begin thinking about what you could donate —we will put anything up for auction.

(Please note that if your item does not sell, you will need to take it home with you.) If anyone

would like to coordinate/run the Silent Auction, please see any Board member to sign up!

Current board members will be voted on for continuing in their roles at the next meeting.

We are still looking for a Software Chair. If you are interested, please see any Board member

to sign up! 

We look forward to seeing you all at the June meeting! 

Program Meeting – Penfield Library

Help’s Half Hour
Led by: Carl Schmidtmann

Recorded by Jan Rothfuss

Q: A member reported that he has been getting email messages sent in HTML but converted

to plain text. He is using Outlook.

A: It is likely that they are encapsulating it, not telling your program that it is HTML. You

may also want to check for an attachment—sometimes the message is in HTML there.

Sometimes gif images are turned off to protect your machine. 

Q: His Windows Media Player is freezing up after it starts to work.

A: You may need to uninstall and reinstall. You may need to check your video and audio

drivers. You can go into Dell’s website and then check for all updates.

Q: A member has now been catching podcasts. He is looking for free software podcasts. 

A: If under housestuffworks.com includes a lot of good items that are not too long.

Note: There is a new video on FaceBook manners. It can be found through google and is fun
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to watch.

Q: How can you use virtual machine capabilities?

A: Carl told him that he uses VM to create a Windows machine on his Mac. You can also try

different versions of software like Linux. If it does not work as expected, you can just wipe it

off. Another member uses a virtual private server. This spreads out the usage of those who are

grabbing more of the resources from others. You have a guaranteed minimum level of CPU

and memory. It often is cheaper than putting in an actual piece of new hardware. It is scalable

so that you can buy only what you need. 

Q: Does anyone use the Windows key next to the Alt key?

A: Windows D minimizes all windows. Windows L will bring up your screen saver and lock

your PC. Check for others under shortcut keys.

Q: A member copied items to a DVD. But now the DVD just spins.

A: Try putting it back into the drive and use your original software to make sure that you have

closed the writing. Under snapfiles.com, there is a recovering tool that might help.

Q: What is involved with a sandbox creation?

A: It is used like a virtual machine. Google it as sandboxie.

The Lighter Side
Tech Support: “What version of Windows are you running?”

Customer: “I got the computer in 2003, so I think it’s a Windows 2003. Or maybe it’s a

Windows 2004? I got it late in the year.”

Tech Support: “Um, ok.”

Customer: “Is that wrong?”

Tech Support: “No, no, that sounds about right. Tell me, would you know what service pack

you have for that?”

Customer: “Well, when I got to the register, the young man who rang me up said was about

the 5th person to buy it. So it might be service pack 5.”

Tech Support: “Do you know what operating system you’re on?”

Customer: “Hmmm...what would be a good answer?”


